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Wprowadzenie 

Ćwiczenie przygotowano z wykorzystaniem oprogramowania Adobe Lightroom 6.1. 

1. Zdjęcia nocne 

Pierwsze zdjęcie, którego obróbką zajmiemy się to zdjęcie nocne (Ryc. 1). Zostało 

wykonane w Lądku-Zdroju. Na pierwszym planie mamy park zdrojowy, w którego tle 

znajduje się Zakład Przyrodoleczniczy „Wojciech” – jeden z najstarszych i najokazalszych 

obiektów tego typu w Polsce.  

Budynek powstał w latach 1878–1880 według projektu Hermanna Völkela, 

w miejscu dawnego, XVII-wiecznego, ośmiobocznego „Kąpieliska Marii”. Architektonicznie 

nawiązuje do historyzmu (tzw. styl rzymski). Łączy elementy włoskiego renesansu, archi-

tektury palladiańskiej oraz manieryzmu i klasycystycznego baroku, zinterpretowanych 

w duchu neoklasycyzmu. 

W kontekście fotograficznym budynek emanuje monumentalizmem, luksusem 

i duchem uzdrowiskowej arystokracji. Nocne zdjęcie powinno podkreślać jego pałacowy, 

widowiskowy charakter poprzez kontrast głębokich cieni i ciepłego, złotego światła ilumi-

nacji. 
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A 

 

B 

 

Ryc. 1. Zakład przyrodoleczniczy „Wojciech” w Lądku-Zdroju, ISO 100, f/14, 28 sek. A – 

RAW (przed obróbką), B – JPG (po obróbce). fot.: T. Bartuś 
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Balans bieli (White Balan-

ce – WB) to proces korekty 

kolorów, którego celem jest 

usunięcie z fotografii niepo-

żądanych zażółceń lub zanie-

bieszczeń spowodowanych 

temperaturą barwową świa-

tła, w jakim zdjęcie zostało 

zrobione. Balans bieli konfi-

guruje aparat (lub program 

graficzny) tak, aby obiekty, 

które w rzeczywistości są 

neutralnie białe lub szare, 

wyglądały na białe lub szare 

również na gotowym zdjęciu. 

BALANS BIELI 

1.1. Identyfikacja mankamentów 

a) Dwa źródła światła o różnych temperaturach barwo-

wych (oświetlające park i deptak oraz fasadę budynku) 

spowodowały, że mamy tu problem z balansem bieli. 

Spójrz na barwę światła padającego na figury w parku 

i schody. To nienaturalny kolor pomarańczowo-

brązowy. Musimy go skorygować. 

Głównym powodem istnienia balansu bieli jest fakt, że 

ludzki mózg potrafi automatycznie adaptować się do zmian 

oświetlenia, podczas gdy matryca aparatu rejestruje światło 

bezkrytycznie i dosłownie. 

Gdy czytasz białą kartkę papieru w pełnym słońcu, 

w cieniu drzewa, czy przy świeczce, Twój mózg „wie”, że kartka 

jest biała i tak ją widzisz. Jednak dla aparatu każde z tych źró-

deł światła ma zupełnie inną barwę, mierzoną w Kelwinach (K). 

Na przykład światło świecy lub żarówki (ciepłe) emituje silną 

dominantę żółto-pomarańczową (około 2000–3000 K), zaś światło w cieniu lub zachmu-

rzone niebo (chłodne): emituje dominantę niebieską (około 7000–9000 K). 

Kluczowe wyzwania i problemy związane z WB 

• Dominanty barwne (Color Cast): Jeśli aparat błędnie zinterpretuje oświe-

tlenie (zwłaszcza w trybie automatycznym), całe zdjęcie zyska nienaturalny 

zafarb. Ludzka skóra może wyjść chorobliwie żółta lub trupio blada. 

• Mieszane źródła światła: To jedno z najtrudniejszych zadań dla fotografa. 

Sytuacja, w której w jednym kadrze miesza się np. zimne światło wpadające 

przez okno z ciepłym światłem domowych żarówek. Poprawienie balansu 

bieli dla wnętrza sprawi, że widok za oknem stanie się jaskrawo niebieski. 

• Wpływ formatu pliku (RAW vs. JPEG): Jeśli fotografujesz w formacie JPEG, 

balans bieli jest „wpalany” w plik przez procesor aparatu i jego późniejsza 

drastyczna zmiana w programie komputerowym niszczy jakość zdjęcia. 

W przypadku plików RAW informacja o kolorze jest surowa – balans bieli 

można bezstratnie i całkowicie zmienić na etapie postprodukcji. 

b) zbyt ciemna elewacja budynku, 

c) spore niedoświetlenie tła (noc) oraz prześwietlenie fragmentów elewacji od świa-

teł o wyraźnie innej temperaturze barwowej niż lampy oświetlające deptak, 
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d) ogólne modyfikacje, wyostrzanie, redukcja szumów. 

1.2. Modyfikacje 

1.2.1. Włącz zaznaczanie utraty szczegółów w światłach i cieniach. 

1.2.2. WB > custom > Temp = 2230 (poprawa WB w rejonie schodów, niestety 

światła na elewacji zmieniły swe zabarwienie na wyraźnie niebieski odcień – 

pozbędziemy się tego niżej). 

1.2.3. Tone > Auto (pozbywamy się wyraźnego niedoświetlenia w tle). 

1.2.4. Spróbujemy (na ile to możliwe) pozbyć się lub zmniejszyć prześwietlenia 

frontowych fragmentów budynku oświetlonych lampami kinkietowymi za-

montowanymi na elewacji: Highlights > -74. 

1.2.5. Zdjęcie sprawia wrażenie mało kontrastowego, wymaga niewielkiej modyfi-

kacji kontrastu, który da także efekt większej ostrości: Contrast > 14. 

1.2.6. W celu usunięcie niewielkiej mgiełki, mętności na zdjęciu, powinniśmy zmo-

dyfikować przejrzystość (Clarity). Modyfikacja polega na zwiększeniu kon-

trastu półcieni: Clarity > 24. Zdjęcia po modyfikacji przejrzystości zyskują 

zawsze na ostrości. Poprawna korekcja w większości przypadków powinna 

polegać na zwiększeniu wartość do około +25 lub nawet +50. Nie powinno 

się korygować „in +” jedynie tych fotografii, które ze względu na ich kompo-

zycję lub sposób ujęcia tematu powinny być bardzo nastrojowe i mniej kon-

trastowe (np. portrety dzieci lub portrety typu glamour). 

1.2.7. W celu poprawy ogólnej intensywności kolorów, można w niewielkim zakre-

sie poprawić parametr Saturation > 6. Działanie tego narzędzia posiada 

pewną wadę. Co prawda poprawia ono intensywność barw mdłych 

i niewyraźnie zaznaczonych, ale niejako przy okazji zostaną zmodyfikowane 

także i te, które były już pierwotnie nasycone. Staną się one wtedy zdecy-

dowanie zbyt intensywne, a zdjęcie będzie wyglądało nienaturalnie. Ze 

względu na dość stonowany charakter kompozycji, proponuję postąpić nieco 

bardziej subtelnie i skorzystać z narzędzia Vibrance (intensywność). Zasto-

sowanie go również powoduje zwiększanie nasycenia barw, ale zmodyfiko-

wane zdjęcia wyglądają znacznie bardziej naturalnie. Algorytm działania te-

go suwaka sprawia, że mdłe, spłowiałe kolory stają się znacznie intensyw-

niejsze, zaś te, które były żywe i wyraziste, są traktowane znacznie łagod-

niej. Poza tym, algorytm został opracowany w taki sposób, by w możliwie 

niewielkim stopniu wpływał na kolorystykę skóry. Vibrance > 13. 

1.2.8. Przejdź do zakładki krzywych tonalnych (Tone Curve). 

1.2.9. Zakres tonalny zdjęcia wydaje się w porządku i nie wymaga poważnych mo-

dyfikacji krzywej tonalnej. Można co najwyżej spróbować wyciągnąć przepa-
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lenia na elewacji. W tym celu kliknij na narzędzie wyboru fragmentu zdjęcia, 

którego tony chcemy zmodyfikować (Adjust Tone Curve by dragging in the 

photo), a następnie obniżymy Highlight Tones > -65. 

1.2.10. Przechodzimy do precyzyjnej modyfikacji kolorów HSL (Hue – odcień, Sa-

turation – nasycenie, Luminance – jasność). Po pierwsze musimy pozbyć 

się nienaturalnego niebieskiego światła na elewacji budynku. Luminance > 

Blue > 55, Saturation > Blue > -45. 

1.2.11. Przechodzimy do zakładki Detail, w której spowodujemy wyostrzenie zdję-

cia. 

 

 

 

 

 

 

1.2.12. Najpierw zajmiemy się określeniem siły wyostrzania. Przejdź do Sharpe-

ning > Amount. 

 

 

 

 

 

 

 

1.2.13. Zmodyfikuj Sharpening > Amount > 62. 

1.2.14. Przejdźmy do narzędzia Sharpening > Radius. 

 

 

 

 

 

 

1.2.15. Zmodyfikuj Sharpening > Radius > 1.2. 

1.2.16. Przejdź do Sharpening > Detail. 

Sharpening > Radius (Promień) 

Ten suwak określa grubość/szerokość krawędzi, na którą wpływa wyostrzanie. Mierzony jest w pikselach. 

Decyduje o tym, jak daleko od samej krawędzi linii ma sięgać efekt zwiększania kontrastu. W praktyce, 

niski promień (np. 0,5–1,0) jest idealny do drobnych detali (tekstura skóry, włosy, krajobrazy z daleka). 

Wyostrza on tylko same najcieńsze linie. Wysoki promień (np. 1,5–3.0), jest przydatny do obiektów 

o miękkich, grubych krawędziach (np. duże obiekty, architektura z bliska). Zbyt wysoki promień tworzy 

wokół obiektów brzydkie, jasne obwódki (tzw. „halo”). 

Sharpening > Amount (Ilość) 

Określa, jak bardzo jasne piksele na krawędziach staną się jaśniejsze, a ciemne – ciemniejsze. W praktyce, 

im wyższa wartość, tym zdjęcie wydaje się „ostrzejsze”. Jeśli jednak przesadzisz, na zdjęciu pojawi się 

brzydkie, cyfrowe ziarno (szum) oraz nienaturalny, „przepalony” wygląd 

Sharpening (wyostrzanie) 

Podczas procesu wyostrzania zdjęć warto powiększyć zdjęcie i dokonywać niezbędnych modyfikacji na pod-

stawie widoku 1:1. Dodatkowo przyciśnięcie klawisza Alt podczas przesuwania suwaków spowoduje, że obraz 

będzie widoczny w skali szarości. To pozwala lepiej panować nad czułymi narzędziami wyostrzania. 
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1.2.17. Zmodyfikuj Sharpening > Detail > 8. 

1.2.18. W tej samej zakładce (Detail), przechodzimy do grupy narzędzi odszumia-

jących Noise Reduction. 

 

 

 

 

 

 

1.2.19. Zdjęcie zostało wykonane ze wzmocnieniem (czułością) ISO 100 i szum 

który dobrze jest widoczny w powiększeniu (zwłaszcza 3:1), jest efektem 

długiego naświetlania i słabej jakości matrycy aparatu. Luminance > 62. 

1.2.20. Aby zachować więcej szczegółów zwiększ poziom Detail do 65. 

1.2.21. Zwiększ suwak Contrast do 40. 

 

 

 

 

 

Sharpening > Detail (Szczegół) 

Ten suwak kontroluje, jak małe elementy i tekstury na zdjęciu zostaną poddane wyostrzaniu. Przy niskich 

wartościach Lightroom ignoruje drobne szumy i wyostrza tylko główne, wyraźne krawędzie. Przy wysokich 

wartościach program próbuje wyostrzyć absolutnie wszystko – nawet najmniejszą teksturę. 

W praktyce, niskie wartości są dobre do portretów, gdzie zależy nam na wygładzeniu skóry, ale wyostrze-

niu oczu i rzęs. Wysokie wartości świetne nadają się do wyciągania drobnych detali, takich jak faktura skał, 

kora drzew czy materiał ubrań. 

Uwaga: wysokie wartości mocno podbijają cyfrowy szum na zdjęciu zrobionym przy słabym świetle. 

Noise Reduction (Redukcja szumu) 

Sekcja służy do czyszczenia zdjęć z cyfrowego ziarna, które pojawia się zazwyczaj przy fotografowaniu na 

wysokich czułościach ISO (np. w trudnych warunkach oświetleniowych). 

W Lightroomie szum dzieli się na dwa rodzaje: Luminance (szum jasności – przypominający tradycyjne 

ziarno filmowe) oraz Color (szum kolorowy – brzydkie, kolorowe plamki). Każdy z nich ma swój zestaw 

suwaków. 
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Parametry odszumiania „Color” pozostawimy w ustawieniach domyślnych. 

 

 

 

 

 

 

 

Szum Jasności (Luminance Noise) 

Odpowiada za usuwanie szarego, „piaskowego” ziarna. 

Luminance (Jasność) 

To główny suwak w tej sekcji, określający siłę usuwania szumu ziarnistego. Wygładza piksele 

o różnej jasności, zacierając różnice między nimi. W praktyce przesunięcie go w prawo usuwa ziar-

no, ale zbyt wysoka wartość sprawi, że zdjęcie stanie się nienaturalnie gładkie, plastikowe i straci 

ostrość (tzw. „efekt budyniu”). 

Detail (Szczegół) 

Ten suwak pełni rolę „hamulca bezpieczeństwa” dla suwaka Luminance. Kontroluje on ile drobnych 

detali struktury ma zostać uratowanych przed wygładzeniem. Przy niskich wartościach Detail, Ligh-

troom mocno wygładza wszystko. Przy wyższych (powyżej 50) program próbuje odzyskać krawędzie 

i tekstury, które suwak Luminance zdążył już rozmyć. W praktyce, jeśli po użyciu Luminance zdję-

cie stało się zbyt mydlane, zwiększ Detail, aby przywrócić naturalną fakturę (np. porów skóry czy 

tkaniny), uważając jednak, by nie przywrócić z powrotem usuniętego szumu. 

Contrast (Kontrast) 

Kontroluje kontrast na krawędziach detali, które próbuje uratować suwak Detail. Wyższe wartości 

pomagają utrzymać wyraźne odcięcie między jasnymi i ciemnymi obszarami, co zapobiega wrażeniu, 

że zdjęcie jest płaskie po redukcji szumu. Jest przydatny głównie przy zdjęciach architektury lub 

krajobrazów nocnych, gdzie zależy nam na ostrych, kontrastowych liniach budynków czy gwiazd. 

Przy portretach rzadko się go używa, by nie popsuć miękkości skóry. 
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1.2.22. Na koniec pozbędziemy się niepożądanych zniekształceń optycznych wyni-

kających z niedoskonałości obiektywu. W module Library > Metadata > 

EXIF, możemy sprawdzić jakim obiektywem zostało zrobione zdjęcie. W tym 

przypadku jest to obiektyw 17–50mm f/2.8 firmy Tamron. Przechodzimy do 

zakładki Lens Correction > zaznaczamy opcję: Enable Profile Correc-

tion, Lens Profile > Make > Tamron, Model > Tamron SP 17-50 F/2.8 

DiII A16N. Zaznaczone opcje spowodują niewielką modyfikację geometrii 

zdjęcia. 

1.2.23. Ostatnią rzeczą wymagającą zmiany jest rozjaśnienie dachu kopuły budyn-

ku. Dokonamy tego za pomocą narzędzia pędzla (Adjustment Brush) znaj-

Szum Kolorowy (Color Noise) 

Odpowiada za usuwanie losowych, kolorowych pikseli (najczęściej czerwonych, zielonych i niebie-

skich), które najbardziej szpecą cyfrowe zdjęcia. 

Color (Kolor) 

Główny suwak do usuwania kolorowych plamek. Wyszukuje nienaturalnie zabarwione piksele 

w ciemnych partiach i desaturuje je (neutralizuje ich kolor), dopasowując do otoczenia. Domyślnie 

Lightroom ustawia ten suwak na wartość 25, co zazwyczaj wystarcza, by całkowicie pozbyć się 

problemu. Jeśli szum kolorowy nadal widać, przesuń go wyżej. 

Detail (szczegół – dla koloru) 

Określa próg ochrony przejść tonalnych i małych kolorowych detali. Chroni krawędzie różnych kolo-

rów przed rozlewaniem się i mieszaniem ze sobą podczas usuwania szumu. Jeśli na zdjęciu masz 

drobne, blisko siebie położone elementy o różnych, intensywnych barwach (np. kolorowe napisy na 

neonach), wysoka wartość tego suwaka zapobiegnie ich wzajemnemu „zlewaniu się”. Zbyt wysoka 

wartość może jednak przywrócić kolorowe plamki szumu na krawędziach. 

Smoothness (gładkość) 

Decyduje o tym, jak miękkie mają być przejścia między kolorami po usunięciu szumu. Pomaga 

wygładzić duże, jednolite obszary (takie jak tło w studiu czy nocne niebo), na których po usunięciu 

szumu kolorowego mogły pozostać plamy o lekko zmienionym odcieniu. Jeśli po redukcji szumu 

kolorowego na jednolitych powierzchniach widzisz nieestetyczne, wielobarwne „mapy” lub plamy, 

przesunięcie tego suwaka w prawo ładnie je ujednolici i zmiksuje. 
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dującego się bezpośrednio pod histogramem (ostatnia ikona). Klikamy na 

pędzel. Zmniejsz średnicę pędzla Size do około 12, po czym dość dokładnie 

„zamalowujemy” kopułę. Po zamalowaniu całości wybieramy Effect > Cu-

stom, Exposure > 1.00. W zależności od dokładności zamalowania kopuły, 

efekt może się nieco różnić od zamieszczonego poniżej. 

1.2.24. Za pomocą „prawokliku” eksportuj jpg. 
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2. Zdjęcia krajobrazowe z dużym udziałem chmur 

Zdjęcie zostało wykonane z Góry Św. Anny nad Nową Rudą (Ryc. 2). 

A 

 

B 

 

Ryc. 2. Widok z Góry Św. Anny w kierunku północnym. W tle Góry Sowie, w dolinie Nowa 
Ruda, ISO 100, f/22, 1/4 sek., fot.: T. Bartuś 
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2.1. Identyfikacja mankamentów 

a) mały kontrast, 

b) zbyt chłodna i wypłowiała kolorystyka, 

2.2. Modyfikacje 

2.2.1. WB –> custom -> Temp = 5330 (ocieplenie kadru). 

2.2.2. Tone -> Auto (zdjęcie zyskuje na kontraście). 

2.2.3. Pozbywamy się przepaleń na jasnych stropach chmur: Highlights > -16. 

Whites > +13. 

2.2.4. Pod pasem drzew, na skraju polany widoczny jest ostry cień, na którym 

utraciliśmy szczegóły, spróbujmy nieco rozjaśnić ten cień poprzez redukcję: 

Blacks > +7. 

2.2.5. Niestety poprzednie poprawki spowodowały redukcję kontrastu. Poprawiamy 

go: Contrast > 34. 

2.2.6. W celu usunięcie mgiełki atmosferycznej, musimy zmodyfikować przejrzy-

stość: Clarity > 20. Uzyskany efekt najlepiej obserwować w drugim planie 

(np.: szczyty gór). Zdjęcie zyskuje na kontraście i trochę na ostrości. 

2.2.7. Nieznacznie poprawiamy intensywność nieintensywnych barw: Vibrance > 

10, 

2.2.8. A także intensywności kolorów w ogólności: Saturation > 10. Zmiana naj-

bardziej widoczna jest na zieleni trawy i błękicie nieba. 

2.2.9. Przechodzimy do modyfikacji krzywej tonalnej, na której zmieniamy jasność 

półtonów: Tone Curve > Region > Shadows > 39. 

2.2.10. Przechodzimy do precyzyjnej modyfikacji kolorów HSL (Hue – odcień, Sa-

turation – nasycenie, Luminance – jasność). Z powodu nieciekawej kompo-

zycji centralnej, powinniśmy podkreślić znaczenie nieba poprzez modyfikację 

jasności koloru niebieskiego (przyciemnienie): Luminance > Blue > -12. 

2.2.11. Niestety z lewej strony zdjęcia, tuż nad poziomem cumulusów wyraźnie wi-

doczne są dwa artefakty w postaci niewielkich szarych plamek. Ich pojawie-

nie się na zdjęciu związane jest z wysoką wartością przysłony (f/22) i jest 

efektem zabrudzenia matrycy aparatu (wymaga przedmuchania gruszką lub 

przeczyszczenia). Pozbędziemy się ich za pomocą narzędzia: Spot Removal 

(druga ikona od lewej, pod histogramem). Wybieramy: Spot Edit > Clone, 

Size > 30 (wielkość koła narzędzia), Opacity > 100 (pokrycie). 

W następnym kroku klikamy najpierw w centrum pierwszej plamki, później 

na drugą. 
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2.2.12. Po usunięciu artefaktów, powracamy do modyfikacji barw. Podniesiemy na-

sycenie zieleni: Saturation > Green > -31, i jeszcze taka sztuczka powodu-

jąca nabranie przez trawę soczystej barwy: Saturation > Yellow > 16. 

2.2.13. W celu ocieplenia kadru dodajmy jeszcze nasycenia barwie pomarańczo-

wej: Saturation > Orange > 16 oraz Saturation > Red > +56. Podbudu-

jemy tym czerwienie i pomarańcze dachów domów. 

2.2.14. Przechodzimy do zakładki Detail, w której wyostrzymy zdjęcie: Sharpe-

ning > Amount > 90. Warto przy tym powiększyć zdjęcie i dokonywać nie-

zbędnych modyfikacji na podstawie widoku 1:1. Radius > 1,6. 

2.2.15. W tej samej zakładce (Detail), przechodzimy do narzędzia odszumiającego 

Noise Reduction. Zdjęcie zostało wykonane z czułością ISO 100 i szum 

który dobrze jest widoczny w powiększeniu (zwłaszcza 3:1), jest głównie 

efektem dokonanych do tej pory modyfikacji. Luminance > 30. 

2.2.16. Tym razem nie będziemy modyfikować zniekształceń optycznych ale 

sprawdźmy jakim obiektywem było robione zdjęcie (moduł Library > Meta-

data > EXIF). W tym przypadku jest to obiektyw zoom 18–135mm f/3.5–

5.6 firmy Nikkor. 

2.2.17. Ostatnią rzeczą, którą chciałbym zmodyfikować to poprawa nieba 

z chmurami. Zajmiemy się poprawą kontrastu i wyrazistości chmur. Aby 

zmiany odniosły skutek dla całego nieba, a podłoga pozostała bez poprawek, 

zastosujemy Graduated Filter ( filtr stopniowy), dostępny poprzez czwartą 

ikonę od lewej, pod histogramem. Klikamy na to narzędzie po czym przecią-

gamy je z góry na dół od krawędzi zdjęcia po granicę horyzontu. Starajmy 

się jednak zachować poziomy charakter filtra. Po przeciągnięciu zmodyfikuj-

my kolejno opcje filtra: Effect > Custom, Exposure > 0, Contrast > 66, 

Saturation > 2, Clarity > 24, Sharpness > 32. 

2.2.18. Eksportujemy jpg. 
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3. Zdjęcia krajobrazowe z mgiełką atmosferyczną 

Mgiełka atmosferyczna jest często zmorą fotografów krajobrazowych (Ryc. 3). 

A 

 

B 

 

Ryc. 3. Widok z masywu Lovcen na Zatokę Kotorską (Czarnogóra). W dole miasto Kotor, 
ISO 100, f/10, 1/30 sek., fot.: T. Bartuś 
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3.1. Identyfikacja mankamentów 

a) fatalna mgiełka atmosferyczna pozbawiająca kadr jego siły tkwiącej 

w niepowtarzalnym widoku, 

b) zbyt chłodna i wypłowiała kolorystyka, 

c) brak kontrastu,  

d) utrata atutu ciekawych chmur na horyzoncie. 

3.2. Modyfikacje 

3.2.1. WB > custom > Temp = 5793 (ocieplenie kadru). 

3.2.2. Tone > Auto (zdjęcie ulega przyciemnieniu, zyskuje jednak na kontraście 

i wyrazistości kolorów). 

3.2.3. Rozjaśnijmy nieco kadr Shadows > +10. 

3.2.4. W celu poprawy kontrastu, modyfikujemy: Contrast > 56. 

3.2.5. W celu usunięcie mgiełki atmosferycznej i poprawy plastyczności zdjęcia, 

musimy zmodyfikować przejrzystość: Clarity > 29. Niestety z narzędziem 

Clarity nie można przesadzać. Nadmierna modyfikacja parametru spowodu-

je niekorzystną zmianę tekstury obrazu na nienaturalną o typie kolażu. 

3.2.6. Nieznacznie poprawiamy intensywność nieintensywnych barw: Vibrance > 

35. Zdjęcie zyskuje mocno niebieski odcień, który trochę równoważy inten-

sywnie żółta, przepalona słońcem trawa. W następnych krokach zmuszeni 

będziemy pozbyć się nadmiaru tych barw. 

3.2.7. W tym celu zmniejszmy nasycenie barw: Saturation > -20. Jest znacznie 

lepiej, jeszcze tylko ta dominanta niebieskiego koloru. 

3.2.8. Przechodzimy do precyzyjnej modyfikacji kolorów HSL. Musimy zająć się 

niebieskim odcieniem wyraźnie widocznym na grzbiecie z lewej strony zdję-

cia. Przejdźmy do zakładki Hue i przesuńmy balans pomiędzy kolorami 

Aqua i Blue w kierunku Aqua > -47. 

3.2.9. Przejdźmy teraz do zakładki Saturation i zmodyfikujmy kolor Aqua > 100. 

3.2.10. Na koniec przejdźmy do zakładki Luminance i przyciemnijmy kolor Aqua 

> -100. 

3.2.11. Przyciemnijmy jeszcze kolor niebieski Luminance > Blue > -88. 

3.2.12. Przechodzimy do zakładki Detail, w której wyostrzymy zdjęcie: Sharpe-

ning > Amount > 69. Jak zwykle, warto przy tym powiększyć zdjęcie 

i dokonywać niezbędnych modyfikacji na podstawie widoku 1:1. 

3.2.13. W tej samej zakładce (Detail), przechodzimy do narzędzia odszumiającego 

Noise Reduction. Zdjęcie zostało wykonane z czułością ISO 100 i szum 
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który dobrze jest widoczny w powiększeniu (zwłaszcza 3:1), jest efektem 

postprocesingu. Zmień parametr Luminance > 17. Zbyt wysoka wartość te-

go parametru powoduje nienaturalne „wygładzenie” zdjęć i jest bardzo nie-

korzystna. 

3.2.14. Kolejną modyfikacją będzie poprawa nieba z chmurami. Nasze zadanie to 

poprawa kontrastu i wyrazistości chmur. Aby zmiany odniosły skutek dla ca-

łego nieba, a podłoga pozostała bez poprawek, zastosujemy Graduated Fil-

ter (filtr stopniowy), dostępny poprzez czwartą ikonę od lewej, pod histo-

gramem. Klikamy na to narzędzie po czym przeciągamy je z góry na dół od 

krawędzi zdjęcia po granicę horyzontu. Starajmy się jednak zachować po-

ziomy charakter filtra. Po przeciągnięciu zmodyfikujmy kolejno opcje filtra: 

Effect > Exposure, Exposure > -0.5, Contrast > 50, Saturation > 19, 

Clarity > 17, Sharpness > 17. Na koniec, aby zakończyć edycję opcji gra-

dientu, naciśnij przycisk Done. 

3.2.15. Ostatnią, potrzebną modyfikacją sceny będzie pozbycie się zbędnego, od-

wracającego uwagę, pierwszoplanowego elementu, jakim jest fragment 

drewnianej barierki lub ławki. Zadanie to wykonane zostanie przy użyciu na-

rzędzia: Spot Removal (druga ikona od lewej, pod histogramem). Wybie-

ramy: Spot Edit > Clone, Size > 86 (wielkość koła narzędzia), Opacity > 

100 (pokrycie). Potrzebne będą dwa kliknięcia. Należy zadbać o to aby stę-

plowana wartość ładnie i naturalnie komponowała się z pozostałą częścią 

zdjęcia. 

3.2.16. Za pomocą „prawokliku” eksportujemy jpg. 
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4. Zdjęcia w jaskiniach w sztucznym świetle zastanym 

Zdjęcie jakie będziemy obrabiać to jaskinia Niedźwiedzia w Kletnie (Ryc. 4). 

 

B 

 

Ryc. 4. Jaskinia Niedźwiedzia w Kletnie. ISO 100, f/13, 18 sek., fot.: T. Bartuś 
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4.1. Identyfikacja mankamentów 

a) fatalna balans bieli wynikający z nietypowego, nowoczesnego oświetlenia jaskini 

za pocą diod LED, 

b) rozjaśnienie niedoświetlonych fragmentów zdjęcia,  

4.2. Modyfikacje 

4.2.1. Zmieniamy WB na predefiniowany: WB > Tungsten (jaskinia nabiera wła-

ściwych barw). 

4.2.2. Tone > Auto (zdjęcie ulega zbytniemu rozjaśnieniu, a w części centralnej 

nawet przepaleniu. W niektórych fragmentach zdjęcia tracimy szczegóły. 

4.2.3. Rozjaśnijmy nieco zdjęcie. Po kolei zmodyfikujmy jasność pikseli Blacks > 

42 i Shadows > 50. 

4.2.4. Nieznacznie poprawiamy kontrast: Contrast > 30. 

4.2.5. W zdjęciach o dużej ilości szczegółów – głównie architektura, ale także 

w tym przypadku warto zmodyfikować przejrzystość (25–75). Tutaj: Clarity 

> 31. 

4.2.6. Nieznacznie poprawiamy intensywność nieintensywnych barw: Vibrance > 

15. Zdjęcie delikatnie zyskuje na intensywności barw. Jaskinie nie są spe-

cjalnie kolorowe, więc rezygnujemy z użycia narzędzi Saturation i HSL. 

4.2.7. Przechodzimy do zakładki Detail i dość radykalnie wyostrzymy zdjęcie: 

Sharpening > Amount > 59. 

4.2.8. Przechodzimy do narzędzia Noise Reduction. Zdjęcie zostało wykonane 

z czułością ISO 100. Szum, który dobrze jest widoczny w ciemniejszym 

fragmencie zdjęcia, jest efektem długiej ekspozycji i w mniejszym stopniu 

postprocesingu. Luminance > 10. 

4.2.9. Eksportujemy jpg. 
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5. Zdjęcia krajobrazowe w ostrym świetle 

Modyfikować będziemy zdjęcie wyspy Św. Stefana (Ryc. 5). 

 

B 

 

Ryc. 5. Wyspa Św. Stefana (Czarnogóra), ISO 320, f/18, 1/40 sek., fot.: T. Bartuś 

5.1. Identyfikacja mankamentów 

a) Krzywy horyzont, 

b) nic nie wnoszące ½ zdjęcia w suficie, 

c) brak kontrastu, 

d) niewielkie niedoświetlenie kadru, 

e) niewielka mgiełka atmosferyczna, 

f) słaba intensywność barw. 
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5.2. Modyfikacje 

5.2.1. W celu wyprostowania zdjęcia klikamy na narzędzie: Crop Overlay. Zmie-

niamy kąt zdjęcia Angle > -1.19. 

5.2.2. W kolejnym kroku będziemy przycinać górną część zdjęcia. Domyślnie ka-

drowanie zdjęć odbywa się w sposób proporcjonalny, poprzez przeciągnięcie 

krawędzi zdjęcia do pożądanych wymiarów. Aby umożliwić nieproporcjonalną 

modyfikację proporcji zdjęcia, zmuszeni jesteśmy zwolnić blokadę proporcji. 

Symbolizuje ją mała kłódka znajdująca się z prawej strony zakładki narzę-

dzia Crop & Straighten. Po odblokowaniu, przeciągamy górną krawędź 

zdjęcia do takiego poziomu aby wyspa znajdowała się centrum kadru. 

5.2.3. Dokonujemy nieznacznej modyfikacji WB > Custom > Temp = 5103 (ocie-

plenie kadru). Zyskujemy przy okazji zmianę koloru wody na lekko lazurową. 

5.2.4. Tone > Exposure > +0,47. 

5.2.5. Poprawiamy nieznacznie kontrast: Contrast > + 27. 

5.2.6. Poprawiamy przejrzystość zdjęcia: Clarity > + 24. 

5.2.7. Nieznacznie poprawiamy intensywność barw za pomocą: Vibrance > 10 

oraz: Saturation > 3. 

5.2.8. Zdjęcie wygląda całkiem w porządku. Można się jednak pokusić o drobne 

modyfikacje najważniejszych kolorów. Przechodzimy do precyzyjnej modyfi-

kacji kolorów HSL. Modyfikujemy jasność koloru niebieskiego (przyciemnie-

nie): Luminance > Blue > -22. Radykalnie rozjaśniamy lazurowy kolor wo-

dy przy brzegu: Luminance > Aqua > 93. Nieznacznie rozjaśniamy barwę 

dachówek: Luminance > Orange > 9. Silnie rozjaśniamy zieleń drzew: 

Luminance > Green > 55. 

5.2.9. Nie ma potrzeby modyfikacji krzywej tonalnej. 

5.2.10. Przechodzimy do zakładki Detail i mocno wyostrzamy zdjęcie: Sharpe-

ning > Amount > 71. 

5.2.11. Przechodzimy do odszumiania - Noise Reduction. W związku z tym, że 

zdjęcie zostało wykonane z czułością ISO 320, zawiera dużą ilość szumu (ty-

powe dla Nikon D80) – zob. powiększenie. W związku z powyższym istnieje 

potrzeba bardziej radykalnego niż zwykle odszumienia kadru: Luminance > 

30. 

5.2.12. Eksportujemy jpg. 
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6. Prostowanie geometrii zdjęć robionych obiektywami 

szerokokątnymi 

Modyfikacjom poddamy zdjęcie meczetu w Starym Barze (Ryc. 6). 

 

B 

 

Ryc. 6. Meczet w Stari Bar (Czarnogóra), ISO 320, f/14, 1/50 sek., fot.: T. Bartuś 
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6.1. Identyfikacja mankamentów 

a) wyprostowanie wieży lewego minaretu, 

b) nieznaczne ocieplenie zdjęcia, 

c) niewielkie modyfikacje kolorów  

6.2. Modyfikacje 

6.2.1. Na wstępie należy pozbyć się niewielkiej szarej plamki (artefakt) widocznej 

przy lewej krawędzi zdjęcia. Wybieramy narzędzie: Spot Removal, dobie-

ramy wielkość koła narzędzia: Size > 48, Opacity > 100 i stemplujemy 

plamkę. 

6.2.2. Dokonujemy nieznacznej ocieplenia WB. Wybieramy predefiniowany WB > 

Daylight. Obraz zyskuje na delikatnym ciepłym zabarwieniu. 

6.2.3. Tone > Auto (pozbywamy się znacznej ilości półtonów). Rośnie kontrast. 

Zdjęcie zyskuje na przejrzystości. 

6.2.4. Skorygujmy Exposure > + 0.35. 

6.2.5. Otwieramy teraz narzędzie znajdujące się w zakładce: Lens Correction. 

Zaznaczamy Enable Profile Correction > Manual. Wybieramy suwak: 

Transform > Vertical > -26, Distorsion > -17 oraz Rotate > -1.3. Zdję-

cie wydaje się wyprostowane. Niestety następstwem każdego prostowania 

jest utrata fragmentów zdjęcia w rejonie narożników (w tym przypadku dol-

nych). Zmusi nas to w pewnym momencie do odpowiedniego wykadrowania 

i przycięcia zdjęcia. 

6.2.6. Poprawiamy nieznacznie kontrast: Contrast > 60. 

6.2.7. Poprawiamy przejrzystość zdjęcia: Clarity > 33. 

6.2.8. Nieznacznie poprawiamy intensywność barw za pomocą: Vibrance > 20. 

6.2.9. Zdjęcie wygląda dobrze. Zmodyfikujemy tylko kolor nieba, zieleni 

i pomarańczy w tle skał. Przechodzimy do precyzyjnej modyfikacji kolorów 

HSL. Modyfikujemy jasność koloru niebieskiego: Luminance > Blue > -16. 

Podkręcamy nieco żółtą barwę, która sprawi, że zieleń będzie nieco żywsza: 

Luminance > Yellow > -27. Nieznacznie przyciemniamy barwę zwietrzeli-

ny skał: Luminance > Orange > -23. 

6.2.10. Nie ma potrzeby modyfikacji krzywej tonalnej. 

6.2.11. Przechodzimy do zakładki Detail i dość mocno wyostrzamy zdjęcie: Shar-

pening > Amount > 59. 

6.2.12. Przechodzimy do odszumiania – Noise Reduction. W związku z tym, że 

zdjęcie zostało wykonane z czułością ISO 320, zawiera dużą ilość szumu (ty-

powe dla Nikon D80) – zob. powiększenie. Istnieje konieczność odszumienia 

kadru: Luminance > 31. 
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6.2.13. Za pomocą narzędzia Crop Overlay (druga ikona od lewej pod histogra-

mem) kadrujemy proporcjonalnie zdjęcie. 

6.2.14. Eksportujemy jpg. 
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7. Zdjęcia w muzeach i przy sztucznym świetle zastanym 

Zmodyfikujemy zdjęcie z muzeum Jaskini Niedźwiedziej w Kletnie (Ryc. 7). 

 

B 

 

Ryc. 7. Rekonstrukcja szkieletu niedźwiedzia jaskiniowego w pawilonie wystawowym 
przy wejściu do jaskini Niedźwiedziej w Kletnie (Masyw Śnieżnika), ISO 100, f/20, 3 
sek., fot.: T. Bartuś 
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7.1. Identyfikacja mankamentów 

Zdjęcie zostało wykonane w bardzo trudnych warunkach oświetleniowych w świetle 

zastanym. Pawilon wystawowy, poprzez wysoko umieszczone okna, oświetlany jest świa-

tłem naturalnym. Niestety nie jest go zbyt wiele. Witryny wystawiennicze umieszczone 

w szklanych gablotach posiadają swoje sztuczne oświetlenie. Stanowi je wielopunktowe 

oświetlenie oparte na diodach LED. Zdjęcie robione było na statywie, a czas naświetlenia 

wynosił aż 3 sek. Sytuację dodatkowo utrudniały refleksy światła powstające na szybie 

witryny. Zdjęcie było robione bez użycia filtra polaryzacyjnego. Automatyczny WB nieco 

się w tej sytuacji pogubił. Drugoplanowe tło oświetlone światłem naturalnym uzyskało 

wyraźnie niebieskawe zabarwienie. Szkielet niedźwiedzia jaskiniowego, z powodu długie-

go czasu naświetlania uzyskał intensywnie pomarańczową barwę. Podstawowym zada-

niem postawionym sobie przed obróbką będzie: 

a) poprawienie balansu bieli, 

b) korekcja zbyt intensywnej, pomarańczowej poświaty od światła sztucznego,  

c) ogólne rozjaśnienie zdjęcia. 

7.2. Modyfikacje 

7.2.1. Dokonujemy korekcji WB. Wybieramy narzędzie White Balance Selector 

(ikonka z pipetą znajdująca się w zakładce: Basic > WB). Szukamy na zdję-

ciu miejsca o barwie ciemno-szarej (współczynnik odbicia światła 18%). 

Oczywiście program nie podpowie nam który piksel ma takie zabarwienie. To 

my musimy zdecydować, który uznamy za 18%-ową szarość i reszta pikseli 

zostanie skorygowana do tego wzorca. Proponuję wybrać miejsce znajdujące 

się na ciemno-szarej framudze u podstawy witryny. W moim przypadku, wy-

brany piksel zmodyfikował WB: Temp > 7550, Tint > +28. 

7.2.2. Tone > Auto. Zdjęcie ulega znacznemu rozjaśnieniu. Rośnie też kontrast 

zdjęcia i przejrzystość. 

7.2.3. Poprawiamy kontrast: Contrast > 35. 

7.2.4. Poprawiamy przejrzystość zdjęcia: Clarity > 31. 

7.2.5. Aby pozbyć się nadmiaru intensywność barw, ujmujemy nieco nasycenia: 

Vibrance > -13. 

7.2.6. Zdjęcie ciągle jest dość ciemne. Możemy je jeszcze trochę rozjaśnić przy 

użyciu krzywych tonalnych. Wybieramy narzędzie: Tone Curve -> Adjust 

Tone Curve by dragging in the photo. Wybieramy jakieś szare, ciemne 

miejsce znajdujące się w zacienionym drugim planie i bez zwalniania lewego 

przycisku myszy, w celu rozjaśnienia cieni przeciągamy kursor, aż do uzy-
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skania pożądanego efektu w górę. Wymagany efekt można też uzyskać dro-

gą wpisania obok suwaka Darks wartości +13. 

7.2.7. Zdjęcie wygląda nieźle chociaż ciągle w pierwszym planie dominuje poma-

rańczowe światło sztucznego oświetlenia ekspozycji. Ta intensywna barwa 

wynika ze źle dobranej temperatury barwowej tego źródła światła (WB). 

Zmodyfikujemy tylko kolor pomarańczowy. Przechodzimy do precyzyjnej 

modyfikacji kolorów HSL. Radykalnie modyfikujemy nasycenie koloru poma-

rańczowego: Saturation > Orange > -52. 

7.2.8. Przechodzimy do modyfikacji odcieni Hue i modyfikujemy balans pomiędzy 

kolorami żółtym i pomarańczowym: Hue > Orange > +11. 

7.2.9. Przechodzimy do zakładki Detail i mocno wyostrzamy zdjęcie: Sharpening 

> Amount > 78. 

7.2.10. Przechodzimy do odszumiania - Noise Reduction. W związku z tym, że 

zdjęcie zostało wykonane z czułością ISO 100, zawiera niewielką ilość szu-

mu. Wystarczy zatem kosmetyczna korekcja: Luminance > 15. 

7.2.11. Eksportujemy jpg. 


